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When you start Inspiration, you're in Diagram view. The Main Idea symbol appears in the center of your screen, with the placeholder text, Main Idea, already selected. All you do is type keywords (not details - we’ll do that later).

Rapid Fire
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Use RapidFire when you want to brainstorm, capturing your ideas quickly without worrying about their order. You add ideas rights into the selected symbol, letting Inspiration create new symbols for your ideas.

· Select your Main Idea (or any other symbol).

· Click the RapidFire button and the lightning bolt appears.

· Type a new idea and press Enter.

· Type another idea and press Enter.

· Click the RapidFire button to turn it off.

Editing Text

To fix any errors in symbols, double click the text in the symbol, then select the words you want to change and type over them.

Moving the symbols

Click and drag the symbol.


Click outside of the diagram to deselect the symbol.

Create
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Use the Create buttons to quickly build your diagram.

· Select the symbol the new symbol will be connected to.

· Position the mouse pointer over the arrow on one of the Create buttons.

Notice how the arrow is highlighted to show you the direction in which the new idea symbol will be created.

· Click the arrow you wish.

· The new symbol connects to the selected symbol at the angle you chose.

· Type your information and try another one.

Adding Unconnected Symbols

[image: image6.png]


Drag symbols over

· Find a symbol on the Symbol Palette that you like.  

· Click on it and drag it over to your diagram.

· Type your information and try another one.

Point and Type

· Choose a symbol from the Symbol Palette.

· Click in the open area on your diagram where you want a new symbol.

· Type your information.

· A symbol pops up to hold the information.

· Click away from the symbol to deselect it.
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 Use the F8 key to toggle the 

Symbol Palette on and off.

Linking Unconnected Symbols
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Now that we have unconnected symbols, we may want to link them to our other ideas.  We will link from the primary symbol to the secondary symbol.


Use the Link button

· On the toolbar, click the Link button.

· The cursor becomes a two‑headed arrow. 

· Click the primary symbol to tell Inspiration where you want to draw the link from.

· Click the secondary symbol to indicate where you want to draw the link to.

· The link appears, connecting the primary to the secondary symbol.

· Click the Link button again to turn it off.

Draw connections manually
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Click on primary symbol. 
· Click on one of the four diamonds and drag an arrow to the appropriate symbol.

· When the symbol highlights, release the mouse button.

Save

Click File, Save As... to save your first Inspiration file.

Print

Click File, Print or Print Preview to print your pages.
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Use Print Setup to change the page from Portrait to Landscape.  Sometimes your diagram will fit on the page better this way.

Choose Print Options to fit your diagram to a single page.

Internet Research Planning

Now that we’ve done the brainstorming for our report, we’re ready to research.  Let’s use Inspiration to plan our search of the Internet.

Exercise: Practice what you just learned and create a web of keywords to search on the Net.
Zoom in and out
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It's helpful to zoom in and out when you're working on your diagram. Sometimes you want to take a closer look at a section; at other times, you want to see more of your diagram in the window.

Use the tools at the bottom left to select a Zoom level, Zoom In, or Zoom Out.

Position
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Use the Position tool to reposition your diagram in the window. It's useful when you want some space where you can add more symbols. Just click the Position button and drag the diagram until it's positioned where you want it. Click the button again to turn it 
         off. 

Arrange
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The Arrange tool lets you change your diagram into various kinds of tree charts.
· On the toolbar, click the Arrange button

· The Arrange dialog box appears. 

· Review the selections in the dialog box.

· Choose the options you prefer.
Change symbol shapes, fonts, colors, and links
Change symbol shapes by selecting and then choosing another shape from the palette.  Use the arrows at the top of the palette to find other symbols.

Use the Format menu to change the fonts.

Use the Effect menu to change colors.

Use the Link menu (select the link first) to change the appearance of the links.
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To change more than one symbol at a time use one of the following:

1. Hold down the Shift key when selecting several symbols.

2. Use Edit, Select All to select all the symbols.

3. Click and drag a box around symbols to select them.

Change the symbols as needed.

Save and close the research file.

If you are brainstorming with students, change to large fonts.

Change the main idea font: 

From the menu, choose Format, Size, 18 pt.


Change all the subsequent symbols:

· From the menu, choose File, Diagram Properties.

· Click the Font button.

· Change the size to 18 pt.
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To save your font changes to use each time, choose Save As Template from the File menu and click the Set As Default option.
Creating an Outline

Now that we’ve done our research, let’s add some detail to our diagram.  Open our first brainstorming file.

Add Notes
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Adding notes text is a good way to elaborate upon your ideas. As you add more notes,

you develop your outline into a complete written document.

In Diagram view, notes text is stored in separate notes windows attached to idea symbols. Every idea symbol can have notes text. You can open a notes window at any time to write, to modify your notes and to read what you've written.

· Click the Add Note button.

· The Notes window opens.  Type a sentence or two that fits under this keyword.

· When you're ready to close the notes text window, click the close box on the notes text window or, on the File menu, choose Close.

· Notice that when the symbol with notes is selected it looks a bit different.

Add notes for two or three other keywords.

Outline View
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This is the other way to view your ideas in Inspiration.  Click the Outline button to go to Outline view.  The + next to a topic indicates the topic has subtopics. The ‑ next to a topic indicates the topic has no subtopics.

Add a subtopic
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Adding ideas in the Outline view is as simple as adding an idea symbol in Diagram view. 

· Select a topic by clicking to the left of the topic prefix.

· On the Outline toolbar, click the Add Sub button.

· A new subtopic is created below the topic. It's indented one level in your outline. 

· Type your information.

Add a topic 
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The new topic will be added under the selected topic.  Select the topic you want it under.

· On the Outline toolbar, click the Add Topic button.

· Inspiration inserts a new topic and the cursor moves to the next line so you're   ready to type.

·  Type your information.

Change the level of a topic 
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In Outline view, you can move a topic to the right or to the left, changing its level of importance.

· Select the item to move right or left.

· On the Outline toolbar, click the Right or Left button.

· The topic should move to be either a topic or subtopic, depending on what you chose.

Add text notes to a topic
Adding text notes is a good way to elaborate upon your ideas. As you add more notes,

you are developing your outline into a complete written document.

· With a topic or subtopic selected, press Enter.

· The cursor moves to a new line so you can type in your notes. 

Each topic can have notes that extend from one line to a few paragraphs of information. If you add notes to your topics, you will end up with a written report when you finish. 
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You can also add notes text by selecting a topic and clicking the Add Note button on the Outline toolbar. 

Hiding subtopics/notes
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When you're working with a complex outline, you'll want to hide and show subtopics.

Hiding the detail in your outline makes it easier to see its overall structure.

· Click to the left of a topic to select it.

· On the toolbar, click the Show/Hide Sub button.

· Inspiration hides the subtopics for the selected topic, so there's less detail showing on your outline. 

· On the toolbar, click the Show/Hide Sub button again or double‑click to the left of the topic prefix to show the subtopics
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Just as you can hide and show subtopics, you can hide and show notes text. Just click on the Show/Hide Note button or double‑click the outlined + or ‑ next to the topic.

Rearranging topics 

Inspiration has lots of ways to organize your topics. One of the easiest is to drag topics and place them where you want them.

· Select the topic by clicking to the left of the topic prefix.

· Hold the mouse button down and drag the topic up in your outline until it covers another topic.

· When the dotted rectangle covers the topic above which you want to insert it, release the mouse button. Note how it is inserted between.

Changing the prefixes for your outline
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Everyone has preferences about how things look. For example, you may want to change the kind of prefixes that appear in front of the topics on your outline. It is easy to do.

· On the Outline toolbar, click the Prefix button, then choose a different option. 

Changing Views
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Click the diagram button to return to Diagram View.
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Click the outline button to return to Outline View.

Spell Check
[image: image27.emf]From the menu, choose Utility, Spell Check.  You can do this in both Outline and Diagram View.  Or click the Spell Check button on the toolbar.

Exporting

Now that we have completed our project, we can export it to place in another application.

Exporting the Outline

· Make sure you’re in Outline View.
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From the menu, choose File, Export.

· Export to your favorite word processor.

· Click Save.

· Open your word processor, and choose File, Open to open the outline.

Exporting the Diagram as an image
· Make sure you’re in Diagram View.

· From the menu, choose File, Export.

· Choose the appropriate image type.

Making a Web Page

Making a web page from Inspiration is quick and easy.  You can do it without any experience.  Use this feature to showcase student work and as a research tool.

Add Internet hyperlinks
Inspiration 6 allows you add live Internet hyperlinks to both the outline and diagram.

· In Diagram View, double click on symbol.

· In Outline View, click on outline text.

· From the menu, choose Utility, Internet, URL Hyperlink.

· Type the web page URL in the Hyperlink Address field.

Save the Diagram as a web page
If you have inserted Internet links into your diagram, Inspiration 6 creates an image map in a web page.  You can click on the diagram and follow the links!

· In Diagram View, choose File, Export.

· Choose HTML-Single Web Page.

· Click Save.

Save the Outline to multiple web pages
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From the menu, choose File, Export.

· Choose HTML-Multiple Web Pages.

· Click Save.

Go to Netscape to view your web page.
· Choose File, Open Page

· Click on Choose File

· Browse to find your web page.

· Click Open, and then Open again.

Using Templates

Inspiration comes with lots of templates for use in the classroom.

· From the menu, choose File, Template.

· Choose a template worksheet.

· Open.

· Fill in the blanks.

· Use Save or Save As to save your file when done.

Creating Your Own Template

You can use Inspiration to create your own template for students to fill in for your assignments.

Visit www.graphic.org for lots of info on using graphic organizers in your classroom.

Here are a few types of graphic organizers:


Chain of Events


Clustering


Compare/Contrast


Continuum


Cycle


Family Tree


Interaction Outline


Problem/Solution


Spider Map


Storyboard


Venn Diagram

Create your Inspiration file as before, but create blank symbols for students to fill in. Use some of these other helpful tools.
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Custom Strips
[image: image31.emf]You can use the custom strip symbol to guide students in filling in the boxes.  Choose it from the symbol palette.  Then double click on the side bar to edit it.  

You can draw a picture with the fat bits editor, or put in text with the text editor. 

Drawing tools
Use the draw tools at the bottom of the Inspiration screen to embellish your diagram.  Use the text tool to create headings and labels.
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New Look
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Use New Look to set up the default look for new symbols.

· Select a symbol that already has the shape and the new font we want to use.

· On the Diagram toolbar, click the New Look button.

· Inspiration sets the new look and shows you a preview.

Next time you create a new symbol it will have that New Look.

Saving Internet Images
Inspiration allows you to use any image as part of your diagram, even images found out on the Wild Wild West.  Here’s how to get those images into Inspiration.

· Locate the image you desire.  www.pics4learning.com can be a great place to start.

· Right click on the image.  Use the right mouse button.  Mac users should click and hold on the image.  A shortcut menu will open.

· Netscape users choose Save Image As…

· Decide where you wish to save the image.  The Desktop is often easiest.  Click Save.

· In Inspiration, choose Edit, Insert Graphic.

· Locate your saved image on the Desktop.  Choose Open.

· Internet Explorer users choose Copy Image…

· Switch to Inspiration and choose Edit, Paste…

· If you want to actually save the image to your hard drive, choose Save Picture As… then choose where you wish to save the file.

If one of the diagram’s symbols is highlighted when you bring an image in, the highlighted symbol will be replaced by the new image.  If you don’t want that to happen, be sure to click on the background to deselect any symbols before bringing in the new image.
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RTF stands for Rich Text Format and can be opened in most word processors.








Inspiration supports the use of animated GIFs.  Choose Edit, Insert Graphic.
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